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While Deltek has attempted to verify that the information in this document is accurate and complete, 
some typographical or technical errors may exist. The recipient of this document is solely responsible for 
all decisions relating to or use of the information provided herein. 

The information contained in this publication is effective as of the publication date below and is subject to 
change without notice. 

This publication contains proprietary information that is protected by copyright. All rights are reserved. No 
part of this document may be reproduced or transmitted in any form or by any means, electronic or 
mechanical, or translated into another language, without the prior written consent of Deltek, Inc. 

This edition published October 2018. 

© Deltek, Inc. 

Deltek’s software is also protected by copyright law and constitutes valuable confidential and proprietary 
information of Deltek, Inc. and its licensors. The Deltek software, and all related documentation, is 
provided for use only in accordance with the terms of the license agreement. Unauthorized reproduction 
or distribution of the program or any portion thereof could result in severe civil or criminal penalties. 

All trademarks are the property of their respective owners.  
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Overview 
This document is a compilation of the release notes distributed for the enhancements made in Costpoint, 
Budgeting and Planning, and Time & Expense in October 2018. This document includes descriptions of the 
enhancements in relation with system jars, application jars, libraries, and regulatory updates since the last 
system jar release. 

 
 

Note: Release notes contain summaries of the enhancements made. Refer to the online help for 
additional details.  

          Costpoint 7.1.1 Online Help 

http://help.deltek.com/Product/Costpoint/7.1.1/GA/costpoint_help.htm


Platform Changes 
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Platform Changes  
There are no changes to the platform for this release. 
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Installation Instructions 

Custom Programs Affected 
Sometimes an update can cause custom programs and reports to stop working as expected. Before 
applying this update, consider whether you have any custom programs or reports in the application area 
affected by the update. If so, contact Deltek Support Center at https://deltek.custhelp.com before you 
install the update. 

To Download the HotFix/Feature Update: 
1. From Internet Explorer, go to https://dsm.deltek.com. 

2. Click Run Deltek Software Manager. 

3. Log in using your Deltek Support Center credentials. 

4. In the left pane of the Deltek Software Manager, expand your Deltek product. 

5. Expand the Hot Fixes folder for your product, and select the update to download. 

6. Click Download at the bottom of the screen. 

To Install the HotFix/Feature Update: 
Refer to the installation instructions posted on Deltek's Support Center site, https://deltek.custhelp.com. 

 For Costpoint 7.1.1 updates, refer to Knowledge Base article 79232. 

 For Costpoint 7.0.1 updates, refer to Knowledge Base article 73769. 

 For Costpoint 7.0 updates, refer to Knowledge Base article 67722. 

Before you install this update, please review all previous updates in the Knowledge Base article. You may 
need to install prerequisite programs or database patches (described in the Knowledge Base article) prior 
to installing this update. Note that when you download an update using Deltek Software Manager (DSM), 
all dependent files are automatically downloaded. 

To Check to See if the HotFix is Installed: 
1. Open the application that was updated. 

2. Click Help > About Costpoint from the Costpoint toolbar. This will display a screen that shows 
you the latest update JAR for the application that is open, as well as the latest system JAR and all 
patches applied to the system. 

To Check to See if the Feature is Installed: 
1. Click Help > About Costpoint from the Costpoint toolbar. 

2. Open the Features subtask and click the Feature that was just installed. 

3. Open the Applications subtask. Check the list of applications and their corresponding application 
jars and see if they are correct and have been successfully deployed (highlighted in green). 

4. Open the Patches subtask. Check the list of patches and see if they are correct and have been 
successfully deployed (highlighted in green).  

https://deltek.custhelp.com/
https://deltek.custhelp.com/
https://dsm.deltek.com/
https://deltek.custhelp.com/
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Note: Most of the features installed have their corresponding patches, but not all. 

More Information: 
If you have any questions, please contact Deltek Support Center at https://deltek.custhelp.com 

https://deltek.custhelp.com/
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Costpoint 

Accounting 
There are no changes to Costpoint Accounting in this release. 

Contracts 

Allowing Contract Parent/Child Records in Opportunities and 
Contracts 
Costpoint users may have Indefinite Delivery/Indefinite Quantity (IDIQ) and Blanket Purchase Agreement 
(BPA) type contracts that have parent/child relationships. To allow better tracking of these relationships, 
the Manage Opportunities and Manage Contracts screens have been updated so users can link parent 
contracts to contracts that are awarded under higher-level types of contracts. 

Screen Updates 

The following applications have been modified for this enhancement. 

Manage Opportunities (CTMOPP)  

Two new fields have been added to the Contract Information group box of the General tab of this screen:  

 Prime Contract No — Enter the prime contract number of the contract to be linked to the 
opportunity. This is the number on the signed contract with the customer.  

 Name — Enter the description of the prime contract number.  

The Prime Contract No will represent as the parent contract, and the Task Order No (also found in the 
Contract Information group box) will represent as the child. The values you entered in Prime Contract 
No, Name, and Task Order No will flow to the contract on the Manage Contracts screen when the 
contract record is linked to the opportunity, provided the opportunity is entered in the Main Opportunity 
ID field and the Costpoint Opportunity check box is selected in Manage Contracts.  

When you run the Project Initialization subtask in Manage Opportunities, the Prime Contract No from the 
opportunity will also populate the Prime Contract No in Manage Project User Flow for the projects linked 
to the opportunity. 

Manage Contracts (CTMCNTR)  

These are the changes made on the Manage Contracts screen:  

 In the Identification group box, the Prime Contract No and Name fields now pull data from the 
Manage Opportunities screen if the main opportunity ID linked to the contract is a Costpoint 
opportunity. The default values can still be edited, but the new values entered in Manage 
Contracts will not overwrite the values in Manage Opportunities.  

The Prime Contract No will represent as the parent contract, and the Task Order No (on the 
General tab) will represent as the child. 
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 When you run the Project Initialization subtask in Manage Contracts, the Prime Contract No from 
the contract will also populate the Prime Contract No in Manage Project User Flow for the 
projects linked to the contract.  

 The following changes have been made on the Additional Task Orders subtask on the General 
tab:  

 You can no longer add or edit task orders on this subtask. This subtask is a now read-only 
screen that automatically loads the task orders associated with the prime contract number 
linked to the contract. Note that rows with blank task orders are not displayed on the subtask.  

 The Load Task Orders button and the Master Contract No field have been removed.  

 The following fields have been added to the subtask:  

 Contract ID — This field displays the contract ID.  

 Contract Status — This field displays the contract status.  

 Project — This field displays the project associated with the task order linked to the 
contract’s prime contract number.  

 Record Status — This field displays the task order record status.  

 

System Requirements  

This enhancement requires the following:  

 PATCH3493  

 PATCH3538  

 PATCH3545  

Application JAR Requirements  

The following table lists the Costpoint 7.1.1 screens affected by this update. It includes the required JAR 
version for each application, if applicable. 

Domain Module Application ID Application Name Application File 

Contracts  Opportunities  CTMOPP  Manage 
Opportunities  

cp711_ctmopp_010.zip  

Contracts  Contracts  CTMCNTR  Manage Contracts  cp711_ctmcntr_010.zip  

Warning: The CNTR_TASK_ORDER table, which was used to store the data entered on the 
Additional Task Orders subtask, has been removed as the subtask no longer allows entry of new task 
orders.  

Note that when you apply this enhancement, any task orders that exist in the CNTR_TASK_ORDER 
table will be lost. 
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Projects 

Ability to Reprint Posted Standard Bills  
Costpoint now allows users to print standard bills that have been previously posted. Prior to this feature, 
users would need to save each posted invoice to a file in order to retrieve that invoice to reprint. The 
process gets even more challenging when computing and posting invoices in batches.  

Now, you can select and reprint a specific standard invoice that has been previously posted. All standard 
printing options are available with this new functionality, including the ability to print Accounting 
Classification Reference Number (ACRN) invoices as well as supporting schedules. Note, however, that 
this applies only to standard invoices and not to other invoice types. In addition, when printing posted 
invoices, the Unselected Invoices check box in the Include group box will be disabled on the Print 
Standard Bills screen. 

 
  

Screen Updates  

The following applications have been updated for this enhancement.  

Print Standard Bills (BLRMBIL)  

A new Posting Status group box has been added to this screen, with the following options:  

 Unposted Only — Select this option to print unposted standard bills. If selected, the application 
will operate as in previous functionality, pulling data from the following tables:  

 BILL_EDIT_DETL  

 BILL_EDIT_INVC_HDR  

 BILLING_SUM  

 Posted Only — Select this option to reprint standard bills that have already been posted. If 
selected, the Unselected Invoices check box becomes cleared and disabled. In addition, the 
application pulls data from the new cumulative tables:  

 BILL_EDIT_DETL_CUM — This is a copy of the BILL_EDIT_DETL table at the time of the 
bill posting.  

 BILL_EDIT_HDR_CUM — This is a copy of the BILL_EDIT_INVC_HDR table at the time of 
the bill posting. 

 PROJ_ACRN_DETL_CUM — This is a copy of the PROJ_ACRN_DETL table at the time of 
the bill posting. 

 PROJ_BILL_ACRN_CUM — This is a copy of the PROJ_BILL_ACRN table at the time of the 
bill posting.  

Costpoint uses the billing format assigned to the project in determining if the current and/or 
cumulative columns are printed. 

Note: This feature will only be available for any bills posted in Costpoint after this feature has been 
added. This is because the Post Standard Bills application was modified to post to new tables that will 
be used when reprinting a posted standard bill. 
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For both options, you can limit which bills are printed (for example, by projects, billing groups, or billing 
cycles) using the Selection Ranges group box. You can also select to print one or a range of invoices by 
entering the invoice number(s) in the Invoices Start and/or End fields.  

Post Standard Bills (BLPGEN)  

This application has been modified to update the following cumulative tables when standard bills are 
posted:  

 BILL_EDIT_DETL_CUM  

 BILL_EDIT_HDR_CUM  

 PROJ_ACRN_DETL_CUM  

 PROJ_BILL_ACRN_CUM  

Rows associated with a reversed invoice will be deleted from the same cumulative tables when the 
reversed invoice is posted.  

System Requirements  

This enhancement requires PATCH3516. 

Application JAR Requirements  

The following table lists the Costpoint 7.1.1 screens affected by this update. It includes the required JAR 
version for each application, if applicable. 

Domain Module Application ID Application 
Name 

Application File 

Projects  Billing  BLRMBIL  Print Standard 
Bills  

cp711_blrmbil_023.zip  

Projects  Billing  BLPGEN  Post Standard 
Bills  

cp711_blpgen_012.zip  

 

People 

Employee Self Service Enhancements 
This Costpoint release provides the following enhancements to Employee Self Service applications: 

 Limited Purpose Flexible Spending Account (FSA) Flag  

A Limited Purpose flag for flexible spending account (HSA) was added to support the current 
health savings account (HSA) functionality. The new flag will indicate if the employee's current 
medical FSA was previously flagged as limited purpose. You can select both an FSA and an 
HSA, only if the FSA is limited purpose. This means that it can only be used for dental and vision 
expenses, and not health expenses.  

Prior to this release, you can flag a new FSA election as limited purpose during benefits 
enrollment/life events, however, it does not flow through the system. The new flag ensures that if 
you indicate an FSA as limited purpose, the application will store and display it properly.  
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 Updated Interface on Benefits Enrollment and Life Events/New Hires Screens  

The Benefits Enrollment and Life Events/New Hires screens were updated to support framework 
changes for the expense processing. This includes updates to improve the application’s usability. 

System Requirements 

This enhancement requires the following Costpoint 7.1.1 releases:  

 System JAR 041  

 PATCH3445  

 PATCH3469  

 Common Lib - BENEFITSLIB (cp711_cmnlib_BENEFITSLIB_008.zip)  

Application JAR Requirements 

The following table lists the Costpoint 7.1.1 screens affected by this update. It includes the required JAR 
version for each application, if applicable. 

Domain Module Application ID Application Name Application File 

People  Employee  EMMEHSA  Manage Employee 
HSA Elections  

cp711_emmehsa_005.zip  

People  Employee  HBMMFSA  Manage Employee 
Medical Care FSA 
Elections  

cp711_hbmmfsa_004.zip  

People  Employee 
Self Service  

AOMESSBE  Manage ESS Open 
Enrollment Elections  

cp711_aomessbe_009.zip  

People  Employee 
Self Service  

AOMESSBL  Manage ESS Life 
Event Benefit Elections  

cp711_aomessbl_009.zip  

People  Employee 
Self Service  

AOMESSCS  Manage Taxable Entity 
Settings  

cp711_aomesscs_012.zip  

People  Employee 
Self Service  

AOPESSDB  Update Benefit 
Option/Election Tables  

cp711_aopessdb_013.zip  

People  Employee 
Self Service  

AOPESSUE  Activate Pending ESS 
Benefit Elections  

cp711_aopessue_010.zip  

People  Employee 
Self Service  

ESMBENENROLL  Benefits Enrollment  cp711_esmbenenroll_015.zip  

People  Employee 
Self Service  

ESMCUSTTXT  Manage Custom Text  cp711_esmcusttxt_005.zip  

People  Employee 
Self Service  

ESMLIFEEVENT  Life Events/New Hires  cp711_esmlifeevent_019.zip  
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Costpoint Employee Self Service Enhancements  

This Costpoint release applies the following enhancements to the Employee Self Service applications:  

Activate Pending ESS Benefit Elections (AOPESSUE)  

A new flag for limited purpose FSA (LP_FSA_FL) was added to the Medical Care FSA Elections 
(HB_MED_FSA_ELEC) table.  

Address/Phone (ESMADDRESSPHONE)  

The subtask name changed from “Other Address” to “Add/Change Other Addresses.”  

Benefits Enrollment (ESMBENENROLL)  

The following are updates to the tabs on the Benefits Enrollment screen: 

Beneficiaries Tab  

 The subtask name changed from “New Benefit Plans” to “Select New Beneficiaries for Benefit 
Plans.”  

 The subtask name changed from “Current Benefit Plans” to “Benefit Plans - Current 
Beneficiaries.”  

 The Note subtask was removed and the instructions for saving dependent/beneficiary information 
were moved to the Instructions tab.  

Current Elections Tab  

 The Current Elections subtask was removed.  

 The Current Elections tab now displays the Rollover check box as the first column in the table.  

Dependent FSA Tab  

 A new check box, I do not want to enroll in a Dependent Flexible Spending Account (FSA), allows 
you to opt out of any deductions for a Dependent FSA. When you select this check box, the 
screen will populate the New Contribution amount fields with 0.00 which will eliminate the need to 
enter the amount manually.  

 The instructions on this tab were removed.  

Dependents and Beneficiaries Tab  

 The Note subtask was removed and the information in it was transferred to the Instructions 
subtask.  

Medical FSA Tab  

 A new check box, I do not want to enroll in a Medical Flexible Spending Account (FSA), allows 
you to opt out of any deductions for Medical FSA. When you select this check box, the screen will 
populate the New Contribution amount field with 0.00 which will eliminate the need to enter the 
amount manually.  

 A new Limited Purpose check box under Current Contribution indicates if the currently elected 
medical FSA has been designated as a limited purpose FSA.  

 The label of check box for indicating limited purpose FSAs changed from “Limited Purpose FSA” 
to “I certify that this is a limited purpose FSA and will only be used to reimburse vision and dental 
expenses.”  

 The label changed from “Annual” to “Annual Amount.”  
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 The word “Amount” was added to the label of the fields for the current and new contribution 
amounts based on pay frequency (for example, “Monthly Amount,” “Weekly Amount”).  

 The instructions on the tab were updated.  

Medical HSA Tab  

 A new check box, I do not want to enroll in a Health Savings Account (HSA), allows you to opt out 
of any deductions for a health saving account. When you select this check box, the screen will 
populate the New Contribution amount fields with 0.00 which will eliminate the need to enter the 
amount manually.  

 The label changed from “Annual” to “Annual Amount.”  

 The word “Amount” was added to the label of the field for the current contribution amount based 
on pay frequency (for example, “Monthly Amount,” “Weekly Amount”).  

 The field label changed from “Employee Yearly Contribution Limit” to “Employee.”  

 The field label changed from “Employer Yearly Contribution Limit” to “Employer.”  

 The screen displays a new heading, Year Contribution Limit, for the Employee and Employer 
fields.  

Other Benefits Tab  

 The Other Benefits subtask and the instructions in it were removed.  

 The subtask name changed from “Current Coverage Levels” to “Other Elections – Current 
Coverage Levels” which is similar to other tabs.  

 The subtask name changed from “Select new Coverage Level” to “Select Plan.” This subtask also 
contains the following updates:  

 The Coverage Option and Weekly Premium columns were removed.  

 A new validation ensures that you can only select one coverage option per benefit plan.  

 When you select a plan, the application displays a subtask with the coverage options for that 
plan.  

 A new Select Coverage Level subtask displays all the coverage options for the selected benefit 
plan instead of requiring a lookup. You can select a coverage level/premium on this table. You 
can only select one option per plan. Existing coverage option validations also apply on this table. 
When dependents are eligible for a selected coverage option, they are displayed in the Select 
Dependent Coverage subtask.  

 The Select Dependents for Coverage subtask displays a label to indicate the plan and coverage 
option selected.  

Direct Deposit (ESMDIRDEP)  

 The screen displays an updated warning message when you add a new account.  

 The application now includes the functionality to require a minimum number of direct deposit 
accounts. The application displays the following message when you do not have the minimum 
number of accounts required: “You do not have (min #) account(s) which is the minimum number 
of accounts required by your company. Please enter them in the (pending accounts).”  

Dependents and Beneficiaries (ESMDEPBEN)  

 The Note subtask was removed and the information in it was transferred to the Instructions 
subtask.  
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Designate Beneficiaries (ESMDESBEN)  

 The subtask name changed from “New Benefit Plans” to “Select New Beneficiaries for Benefit 
Plans.”  

 The subtask name changed from “Current Benefit Plans” to “Benefit Plans - Current 
Beneficiaries.”  

 The Beneficiaries subtask which contained instructions was removed.  

Federal Withholding (ESMFEDWH)  

 The screen displays an informational message and disables data fields when the employee does 
not have a tax record. The screen no longer displays an error when the employee does not have 
a tax record.  

 The application is now included in the life event user flow.  

 The State Withholding and Federal Withholding tabs now perform the same actions when the 
user is exempt or does not yet have a tax record.  

 The tab was updated so that applicable state withholding statuses and exemptions will sync with 
the state. This will occur for states that are set up in the Configure State Tax Settings screen to 
require the state filing status to be equal to the federal filing status (Equal to Federal - Filing 
Status check box is selected). Prior to this release, the application only synched with the home 
state.  

Life Events/New Hires (ESMLIFEEVENT)  

The application populates the new field (HB_EMPL_CURR_ELEC.lp_fsa_fl) when it recreates the table 
after you enter the application.  

The following are updates to the tabs on the Life Events/New Hires Screen:  

Address Tab  

 The subtask name changed from “Other Address” to “Add/Change Other Addresses.”  

Beneficiaries Tab  

 The subtask name changed from “New Benefit Plans” to “Select New Beneficiaries for Benefit 
Plans.”  

 The subtask name changed from “Current Benefit Plans” to “Benefit Plans - Current 
Beneficiaries.”  

 The Note subtask was removed and the instructions for saving dependent/beneficiary information 
was moved to the Instructions tab.  

Dependent FSA Tab  

 A new check box, I do not want to enroll in a Dependent Flexible Spending Account (FSA), allows 
you to opt out of any deductions for a Dependent FSA. When you select this check box, the 
screen will populate the New Contribution amount fields with 0.00 which will eliminate the need to 
enter the amount manually.  

 The instructions on this tab were removed.  

Dependents and Beneficiaries Tab  

 The Note subtask was removed and the information was transferred to the Instructions subtask.  
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Direct Deposit Tab  

 The screen displays an updated warning message when you add a new account.  

 The application now includes the functionality to require a minimum number of accounts. The 
application displays the following message when you do not have the minimum number of 
accounts required: “You do not have (min #) account(s) which is the minimum number of 
accounts required by your company. Please enter them in the (pending accounts).”  

Federal Withholding Tab  

 The screen displays an informational message and disables data fields when the employee does 
not have a tax record. The screen no longer displays an error when the employee does not have 
a tax record.  

 The application is now included in the life event user flow.  

 The State Withholding and Federal Withholding tabs now perform the same actions when the 
user is exempt or does not yet have a tax record.  

 The tab was updated so that applicable state withholding statuses and exemptions will sync with 
the state. This will occur for states that are set up in the Configure State Tax Settings screen to 
require the state filing status to be equal to the federal filing status (Equal to Federal - Filing 
Status check box is selected). Prior to this release, the application only synched with the home 
state.  

Medical FSA Tab  

 A new check box, I do not want to enroll in a Medical Flexible Spending Account (FSA), allows 
you to opt out of any deductions for Medical FSA. When you select this check box, the screen will 
populate the New Contribution amount fields with 0.00 which will eliminate the need to enter the 
amount manually.  

 A new Limited Purpose check box under Current Contribution indicates if the currently elected 
medical FSA has been designated as a limited purpose FSA.  

 The label of check box for indicating limited purpose FSAs changed from “Limited Purpose FSA” 
to “I certify that this is a limited purpose FSA and will only be used to reimburse vision and dental 
expenses.”  

 The label changed from “Annual” to “Annual Amount.”  

 The word “Amount” was added to the label of the fields for the current and new contribution 
amounts based on pay frequency (for example, “Monthly Amount,” “Weekly Amount”).  

 The instructions on the tab were updated.  

Medical HSA Tab  

 A new check box, I do not want to enroll in a Health Savings Account (HSA), allows you to opt out 
of any deductions for a health saving account. When you select this check box, the screen will 
populate the New Contribution amount fields with 0.00 which will eliminate the need to enter the 
amount manually.  

 The label changed from “Annual” to “Annual Amount.”  

 The word “Amount” was added to the label of the field for the current contribution amount based 
on pay frequency (for example, “Monthly Amount,” “Weekly Amount”)  

 The field label changed from “Employee Yearly Contribution Limit” to “Employee.”  

 The field label changed from “Employer Yearly Contribution Limit” to “Employer.”  
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 The screen displays a new heading, Year Contribution Limit, for the Employee and Employer 
fields.  

Other Benefits Tab  

 The Other Benefits subtask and the instructions in it were removed.  

 The subtask name changed from “Current Coverage Levels” to “Other Elections – Current 
Coverage Levels” which is similar to other tabs.  

 The subtask name changed from “Select new Coverage Level” to “Select Plan.” This subtask also 
contains the following updates:  

 The Coverage Option and Weekly Premium columns were removed.  

 A new validation ensures that you can only select one coverage option per benefit plan.  

 When you select a plan, the application displays a subtask with the coverage options for that 
plan.  

 A new Select Coverage Level subtask displays all the coverage options for the selected benefit 
plan instead of requiring a lookup. You can select a coverage level/premium on this table. You 
can only select one option per plan. Existing coverage option validations also apply on this table. 
When dependents are eligible for a selected coverage option, they are displayed in the Select 
Dependent Coverage subtask.  

 The Select Dependents for Coverage subtask displays a label to indicate the plan and coverage 
option selected.  

State Withholding Tab  

 The screen displays an informational message and disables data fields when the employee does 
not have a tax record. The screen no longer displays an error when the employee does not have 
a tax record.  

 The application is now included in the life event user flow.  

 The State Withholding and Federal Withholding tabs now perform the same actions when the 
user is exempt or does not yet have a tax record.  

 The tab was updated so that applicable state withholding statuses and exemptions will sync with 
the state. This will occur for states that are set up in the Configure State Tax Settings screen to 
require the state filing status to be equal to the federal filing status (Equal to Federal - Filing 
Status check box is selected). Prior to this release, the application only synched with the home 
state.  

Manage Custom Text (ESMCUSTTXT)  

When you select Benefit Enrollment from the Screen/Application drop-down list, you can select the new 
Instructions option from the Page drop-down list. When you select the Information option, the Information 
Text field loads the default text for this page. You also have ability to change the default Information Text 
value.  

Manage Employee HSA Elections (EMMEHSA)  

The application performs new validations for limited purpose FSAs if the employee has an existing 
Medical FSA election where the dates overlap with the HSA election and the Limited Purpose check box 
was not selected. The application either displays an error, warning, or no message based on the selected 
Enrollment Rules Edit Method option on the Configure Benefit Settings screen.  
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Manage Employee Medical Care FSA Elections (HBMMFSA)  

The Medical FSA Election subtask contains a new Limited Purpose FSA check box which allows you to 
designate an FSA as limited purpose. When you select this check box, you may elect both a Medical FSA 
and HSA. You only submit reimbursement for vision and dental expenses if you select this check box.  

Manage ESS Life Event Benefit Elections (AOMESSBL)  

The Medical FSA Election subtask contains a new Limited Purpose FSA check box which allows you to 
designate an FSA as limited purpose. When you select this check box, you may elect both a Medical FSA 
and HSA. You only submit reimbursement for vision and dental expenses if you select this check box.  

Manage ESS Open Enrollment Elections (AOMESSBE)  

The Medical FSA Election subtask contains a new Limited Purpose FSA check box which allows you to 
designate an FSA as limited purpose. When you select this check box, you may elect both a Medical FSA 
and HSA. You only submit reimbursement for vision and dental expenses if you select this check box.  

Manage Taxable Entity Settings (AOMESSCS)  

A new Minimum Accounts field for direct deposit allows you to have both a maximum and minimum 
number of bank accounts for employees in ESS Direct Deposit. 

State Withholding (ESMSTATEWH)  

 The screen displays an informational message and disables data fields when the employee does 
not have a tax record. The screen no longer displays an error when the employee does not have 
a tax record.  

 The application is now included in the life event user flow.  

 The State Withholding and Federal Withholding tabs now perform the same actions when the 
user is exempt or does not yet have a tax record.  

 The tab was updated so that applicable state withholding statuses and exemptions will sync with 
the state. This will occur for states that are set up in the Configure State Tax Settings screen to 
require the state filing status to be equal to the federal filing status (Equal to Federal - Filing 
Status check box is selected). Prior to this release, the application only synched with the home 
state.  

Update Benefit Option/Election Tables (AOPESSDB)  

A new Limited Purpose FSA flag was added to the Employee Current Benefit Elections table 
(HB_EMPL_CURR_ELEC). 

Known Issues 

This section includes summaries of the issues that exist in this Costpoint release. These issues will be 
resolved in future releases.  

Deltek Defect Tracking Number: 993279  

Description: When you save the record in either the ESS Benefits Enrollment screen or ESS Life 
Events/New Hires screen, the subtasks on the Other Benefits tab display in the wrong order. This issue 
only occurs if you have several options in the Other Benefits tab.  

Customers Impacted: This defect affects Costpoint Employee Self Service users that offer Other 
Benefits to their employees.  
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Workaround Before Fix: None.  

Additional Notes: None.  

Deltek Defect Tracking Number: 1009663; 1010510  

Description: When your system’s display settings are set to use a low screen resolution and/or a text 
size greater than 100%, the fields in the following tabs on the ESS Benefits Enrollment screen and ESS 
Life Events/New Hires screen may not display:  

 Dependents and Beneficiaries  

 Medical FSA  

 Dependent FSA  

 Medical HSA  

 State Withholding (applies to Life Events/New Hires screen only)  

 Federal Withholding – Allowances Worksheet (applies to Life Events/New Hires screen only)  

Customers Impacted: This defect affects Costpoint Employee Self Service users that use a low screen 
resolution and/or a text size greater than 100% in their system's display settings. A smaller laptop or 
monitor size may also result in this issue. Note that this issue does not occur on a tablet screen.  

Workaround Before Fix:  

 For those using a higher resolution (1440x900 or higher) in their display settings  

Change text size to 100% or 125% if you're using a higher resolution. If changing the text size to 
100% or 125% does not work, you may need to increase the resolution.  

 For those using a lower resolution (1450x1050 or lower) in their display settings  

Change text size to 100% if you're using a lower resolution. If changing the text size to 100% 
does not work, you will need to increase the screen resolution.  

Additional Notes: None.  

Deltek Defect Tracking Number: 1011512  

Description: If the Missing Election Method is set to Extend Current Elections, the Activate Pending 
Benefit Elections application should verify the employee’s current medical election is a high-deductible 
plan—if he/she elected an HSA during benefits enrollment, but skipped making a medical election. 

When you run the application after benefits enrollment with the Missing Election Method set to Extend 
Current Elections, the error report should generate an error message if the employee:  

 Has a current non-high deductible medical plan with election dates that overlap the HSA dates  

 Skipped the Medical Insurance election in the ESS Benefits Enrollment or does not go through 
Open Enrollment  

 Elected an HSA in the ESS Benefits Enrollment; or an HSA is manually added by the 
Administrator  

In this scenario, the error report should list the medical plan with the following error message: “The 
medical plan cannot be extended, the employee elected an HSA. An HSA can only be elected with a high 
deductible medical plan.”  

Customers Impacted: This defect affects Costpoint Employee Self Service users that offer both Medical 
and Medical HSA coverage to their employees and allow employees to extend current elections if a 
medical election is not made in the ESS Benefits Enrollment screen.  
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Workaround Before Fix: Prior to processing the employee in the Activate Pending Benefit Elections 
application, you could discuss the options with the employee and update his/her medical or HSA election 
in the Manage Open Enrollment Elections screen. If the employee wants to elect an HSA, his/her medical 
plan must be a high-deductible plan. If the employee does not want to elect a high-deductible medical 
plan, he/she may not elect an HSA.  

If you find this issue after you have already processed the Activate Pending Benefit Elections application, 
you may update the employee’s medical election in Manage Employee Benefit Elections or the 
employee’s HSA election in the Manage Employee HSA Elections screen.  

Additional Notes: None.  

Deltek Defect Tracking Number: 1013760  

Description: A system error displays in the Manage Open Enrollment Elections screen if a record is 
manually added in the HSA Election subtask and the employee does not also have a Medical FSA 
Election record.  

Customers Impacted: This defect affects Costpoint Employee Self Service users that manually enter 
Medical HSA elections in the Manage Open Enrollment Elections screen.  

Workaround Before Fix: Add the employee’s Medical HSA election in the Manage Employee HSA 
Elections screen.  

Additional Notes: This issue does not occur if the Medical HSA election is processed through the ESS 
Benefits Enrollment screen.  

Deltek Defect Tracking Number: 1016521  

Description: The following error message displays on the Manage Open Enrollment Elections screen 
when the Enrollment Rules Edit Method is set to Hard Edit on the Configure Benefit Settings screen and 
you attempt to save a record after manually entering a Medical FSA election for an employee that does 
not have an HSA election: “An HSA and medical FSA can only be elected together if the FSA is limited 
purpose (used for vision and dental only).”  

Customers Impacted: This defect affects Costpoint Employee Self Service users that have the 
Enrollment Rules Edit Method set to Hard Edit on the Configure Benefit Settings screen and manually 
enter a Medical FSA election into the Manage Open Enrollment Elections screen for an employee that did 
not elect an HSA. 

Workaround Before Fix: After adding the Medical FSA election, add an HSA record with an amount and 
save the record. Next, change the HSA amount to 0.00, change the HSA Election Type to None, and 
save the record. This will allow you to save the manually entered Medical FSA election for an employee 
that did not elect an HSA.  

Additional Notes: See the following notes:  

 This issue does not occur if the Medical HSA election is processed through the Benefits 
Enrollment screen.  

 A warning message displays under the same conditions if the Enrollment Rules Edit Method is 
set to Soft Edit on the Configure Benefit Settings screen.  

Deltek Defect Tracking Number: 1007774  

Description: A system error occurs when the employee attempts to open the Life Events/New Hires or 
Manage Open Enrollment Elections screen if benefit options are part of the user flow but the employee 
does not yet have a record set up in Manage Employee Taxes.  
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Customers Impacted: This defect affects employees that attempt to elect benefits in Life Events/New 
Hires or Manage Open Enrollment Elections before an employee tax record is established for that 
employee.  

Workaround Before Fix: Add an employee tax record for the employee. If you do not have complete 
payroll information for the employee, you need to assign only the Pay Cycle to the employee in Manage 
Employee Taxes.  

Additional Notes: None. 

Costpoint - Deltek Talent Management Integration Offboarding Support 
Phase II  
In preparation for the integration of employee offboarding data between Costpoint and Deltek Talent 
Management, this release provides support for additional employee offboarding-related fields in 
Costpoint.  

In phase I of this feature, an information-only date field for the employee’s Last Day Worked was added to 
Costpoint. This specific release, phase II, adds the rest of the applicable offboarding fields that will be 
transferred to Deltek Talent Management. 

 

 

Screen Updates  

Configure Labor Settings (LDMLABOR)  

The screen contains new Employment History Population Method options which you can use to set up 
how the Manage Employee Information screen will create records in the Employee History subtask. 
These methods include the following:  

 Automatic — Select this option if the Manage Employee Information screen should automatically 
create a new Employment History record when you enter a date in the Termination Date field on 
the screen. The Current Hire Date and Termination Date field values will be used to populate the 
new Employment History record. Note that the Employment History record will only be saved if 
you click Save or Save & Continue on the Manage Employee Information screen.  

 Prompt User — Select this option if you want users to be asked, upon entering a date in the 
Termination Date field on the Manage Employee Information screen, if they would like to 
automatically create a new Employment History record. If the user opts to automatically create 
the record, the Current Hire Date and Termination Date fields will be used to populate the new 
Employment History record. If the user does not opt to automatically create the record, the user 
must manually enter the Employment History record. Note that the Employment History record 
will only be saved if you press Save or Save & Continue on the Manage Employee Information 
screen.  

Note: The functionality to transfer offboarding information from Costpoint to Deltek Talent 
Management will be available in a future release of the Transfer Talent Management Data screen 
(EMPHRSDAT). 

Warning: The Import Employee Data preprocessor does not have the functionality to automatically 
populate the employee offboarding-related fields. If you use this application to import employees, you 
will need to manually manage the employee offboarding-related fields on the Employee History table 
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 Manual Entry — Select this option if the user who enters a date in the Termination Date field on 
the Manage Employee Information screen must also manually enter an Employment History 
record.  

Manage Employee Information (LDMEINFO)  

The Manage Employee Information screen contains the following updates for this release:  

 A new Employment History subtask allows you to enter employment history and offboarding 
information for an employee. This subtask is for information only. You can only enter a record in 
this subtask when an employee’s employment has been terminated. This subtask allows you to 
keep an employment history in the event the employee is rehired.  

 The application now has the functionality to automatically populate the Employment History 
subtask when you enter dates in both Termination Date and Last Working Day fields. The 
application will also prompt you if you want to populate the Employment History subtask upon the 
entry of Termination Date and Last Working Day values.  

 The application uses the following new database tables for the employment history information of 
employees:  

 Employment History Details (EMPLOYMENT_HISTORY)  

 Employee History Audit Details (EMPLOYMENT_HISTORY_ADT)  

Manage Rehire Eligibility Codes (EMMREHIREELIG)  

A new screen, Manage Rehire Eligibility Codes, allows you to enter and maintain rehire eligibility codes. 
These codes will be assigned as part of offboarding information provided in the Employment History 
subtask on the Manage Employee Information screen. The rehire eligibility code is required for a 
terminated employee if you are using Deltek Talent Management.  

You must specify whether the rehire eligibility code is for an employee’s eligibility for rehire, ineligibility for 
rehire, or conditional eligibility for rehire. You may also specify a date on which the rehire eligibility code 
becomes inactive. You can only assign rehire eligibility codes that are active as of the employee's 
termination date.  

To access the Manage Rehire Eligibility Codes screen, go to the Costpoint People » Employee » 
Employee Offboarding menu.  

Manage Termination Reasons (EMMTERMRSN)  

A new screen, Manage Termination Reasons, allows you to enter and maintain termination reason codes. 
You can use these codes when you specify a reason for an employee’s termination in the Employment 
History subtask of the Manage Employee Information screen.  

To access the Manage Termination Reasons screen, go to the Costpoint People » Employee » 
Employee Offboarding menu.  

Print Data Dictionary Report (SYRDD)  

The Print Data Dictionary Report now provides information for the following new database tables:  

 Rehire Eligibility Codes (REHIRE_ELIGIBILITY)  

 Termination Reasons (TERM_REASON)  

 Employment History Details (EMPLOYMENT_HISTORY) 

 Employment History Audit Details (EMPLOYMENT_HISTORY_ADT)  
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System Requirements  

This enhancement requires the following Costpoint 7.1.1 releases:  

 Costpoint 7.1.1 System JAR 044  

 PATCH3509  

 PATCH3543  

Application JAR Requirements  

The following table lists the Costpoint 7.1.1 screens affected by this update. It includes the required JAR 
version for each application, if applicable. 

Domain Module Application ID Application Name Application File 

People  Employee  EMMREHIREELIG  Manage Rehire 
Eligibility Codes  

cp711_emmrehireelig_001.zip  

People  Employee  EMMTERMRSN  Manage Termination 
Reasons  

cp711_emmtermrsn_001.zip  

People  Employee  LDMEINFO  Manage Employee 
Information  

cp711_ldmeinfo_023.zip  

People  Labor  LDMLABOR  Configure Labor 
Settings  

cp711_ldmlabor_009.zip  

 

Costpoint Team Management Phase III  
The phase III release of Costpoint Team Management will allow managers to change the data for their 
employees on the Emergency Contacts screen. Other Costpoint Team Management applications will 
allow data changes in later releases.  

If your setup in Configure Team Management Settings screen requires Human Resources (HR) approval 
for data changes in the Emergency Contacts screen, the changes entered by a manager on the 
Emergency Contact screen will create change requests. These change requests will be saved to the 
Team Management change request holding table (HT_CHANGE_REQUESTS). Otherwise, if the changes 
do not require HR approval, Costpoint will directly update the appropriate employee table.  

There can only be one change request for an employee/key field in the holding table and the status can 
be changed by a HR manager. Once a change request has been approved and appropriate tables have 
been updated, the change request will be automatically deleted. If a manager makes a change and it has 
not yet been updated, it will still be available for further edits. The change request table will also save the 
original field data to allow comparison with the new data. If you have set up email notifications on the 
Configure Team Management Settings screen, Costpoint will send an email to the HR manager when a 
record is saved.  

The updated Emergency Contacts screen will also have the following new change request fields:  

 Status — This field displays the request status as Pending, Approved, or Rejected.  

 Status Date — This field displays the timestamp from when the status was last changed.  

 Notes — This field allows both the manager and HR manager to enter comments.  
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Screen Updates  

Manage Change Requests (HTMCHANGES)  

A new screen, Manage Change Requests, allows HR managers to view and approve/reject the change 
requests. HR managers will be able to view the new data against the original data in side by side 
comparisons to allow them to easily view the changes. HR managers will only be able to change the 
Status field and the Notes field in this application. If you enable email notifications on the Configure Team 
Management Settings screen, the application will send an email notification to the change request 
manager when a status changes. 

 

Emergency Contacts (HTMEMERGENCYCONTACT)  

The Emergency Contacts screen includes the following updates:  

 Managers can now change the data for their employees.  

 If data in the change request table exists, the application displays the change request status, 
date, and related comments in a new Change Request Information group box.  

 The Employee Status field is now available in the record header. You can also use the Employee 
Status field in the Find/Query functions of the screen.  

Activate Pending Change Requests (HTPCHANGES)  

A new screen, Activate Pending Change Requests, allows the HR managers to update any approved 
changes to the appropriate employee tables. They will also be given the option to update any pending 
changes to the employee tables if they do not wish to go through the approval process. A report will show 
the potential changes to the employee tables before the actual update. A warning report will display any 
employee data where the employee record was changed after the change request was entered. Users 
are also given the option to delete any rejected change requests.  

This screen can be used by an HR administrator to mass update all the approved and or pending change 
requests made by a manager in Costpoint Team Management.  

System Requirements  

This enhancement requires the following Costpoint 7.1.1 releases.  

 Costpoint 7.1.1 System JAR 044  

 PATCH3524  

Application JAR Requirements  

The following table lists the Costpoint 7.1.1 screens affected by this update. It includes the required JAR 
version for each application, if applicable. 

Note: An HR manager must use a user ID that is associated with an employee ID in order to 
approve/reject the change requests. 
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Domain Module Application ID Application 
Name 

Application File 

People  Team 
Management  

HTMCHANGES  Manage 
Change 
Requests  

cp711_htmchanges_001.zip  

People  Team 
Management  

HTMEMERGENCYCONTACT  Emergency 
Contacts  

cp711_htmemergencycontact_003.zip  

People  Team 
Management  

HTPCHANGES  Activate 
Pending 
Change 
Requests  

cp711_htpchanges_001.zip  

 

Regulatory and Compliance 
There are no changes to Costpoint Regulatory and Compliance in this release. 

Materials Management 

Support for Future Supplier Portal Feature 
PATCH3503 is available to support the future Supplier Portal feature in Costpoint.  

Organization Security – Validation Change for No User ID  
PATCH3534 has been released to support the future Organization Security – Validation Change for No 
User ID feature for employees not associated with any user IDs.  

MMMMEXPDLIB Library  
The MMMMEXPDLIB library contains common business logic, which is shared by the following 
applications:  

 Expedite Manufacturing Orders (PCMMEXPD)  

 Expedite Manufacturing Orders (MRMMEXPD)  

Application JAR Requirement 

Domain Application Name Application JAR 

MM  Expedite Manufacturing Order  cp711_pcmmexpd_011.zip  

MM  Expedite Manufacturing Order  cp711_mrmmexpd_001.zip  

System Requirements  

This enhancement requires the following:  
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 cp711_cmnlib_MMMMEXPDLIB_001.zip  

 cp711_sys_046.zip  

 PATCH3534  

 PATCH7161  

MMMMSRCLIB Library  
The MMMMSRCLIB library contains common business logic, which is shared by the following 
applications:  

 Enter Miscellaneous Inventory Receipts (RCMMSRC)  

 Enter Miscellaneous Inventory Receipts (INMMSRC)  

Application JAR Requirement 

Domain Application Name Application JAR 

MM Enter Miscellaneous Inventory 
Receipts  

cp711_inmmsrc_001.zip  

MM  Enter Miscellaneous Inventory 
Receipts  

cp711_rcmmsrc_014.zip  

System Requirements  

This enhancement requires the following:  

 cp711_cmnlib_MMMMSRCLIB_001.zip  

 cp711_sys_046.zip  

 PATCH3534  

 PATCH7162  

PCMMOISSLIB Library  
The PCMMOISSLIB library contains common business logic, which is shared by the following 
applications:  

 Enter Manufacturing Order Issues (PCMMOISS)  

 Enter Manufacturing Order Issues (INMMOISS)  

System Requirements  

This enhancement requires the following:  

 cp711_cmnlib_ PCMMOISSLIB _002.zip  

 cp711_sys_046.zip  
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MMPFPOLIB Library  
The MMPFPOLIB library contains common business logic, which is shared by the following applications:  

 Print Inventory Reorder Report (INPREORD)  

 Firm Material Requirements Planning Planned Orders (MRPFPO)  

 Firm Master Production Schedule Planned Orders (MSPFPO)  

 Create Purchase Requisitions from Sales Orders (OEPGRQ)  

 Create MO Subcontractor Requisitions (PCMSCRQ)  

 Compute Material Requirements (PCPMRR)  

Application JAR Requirement  

The following table shows the required application JAR affected by this update. 

Domain Application Name Application JAR 

MM Create MO Subcontractor 
Requisitions (PCMSCRQ) 

cp711_pcmscrq_018.zip 

System Requirements  

This enhancement requires the following:  

 cp711_cmnlib_ MMPFPOLIB _009.zip  

 cp711_sys_046.zip  

 

Administration 
There are no changes to Costpoint Administration in this release. 

Reports & Analytics 

Home Dashboard  
The Home Dashboard displays actionable data that you access most often, including information on your 
timesheets, pending tasks, expense reports and authorizations, available leave balances, and 
outstanding expenses. It gives you summary information on these data and at the same time provides 
links to screens where you can view additional details.  

The following are required before you can access Home Dashboard:  

 Deltek Time & Expense license  

 Access to the Dashboards module  

 Access to the Home Dashboard application  

The dashparts on this dashboard source data from Time & Expense and also provide hyperlinks to drill-
though applications in Time & Expense. In addition to the requirements stated above, you must also have 
access to the drill-though application before you can open the drill-through screen. 
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This dashboard is linked to a Home icon so that it is easily accessible as soon as you log in to Costpoint. 
This icon is located on the top-left side of the screen and is visible only to users who are licensed for Time 
& Expense. The dashboard is also accessible from the Reports & Analytics domain (Reports & Analytics 
» Dashboards » Dashboards » Home Dashboard).  

The following dashparts are available on the Home Dashboard:  

 My Tasks — This is a table that lists your pending tasks related to timesheets, expense reports, 
and expense authorizations. Tasks are sorted by priority level, with those on high priority 
displaying on top. You can click a link in the Pending Tasks column to open the Manage 
MyDesktop screen and view more information related to the task selected.  

 My Timesheets — This is a table that displays a summary of your 10 most recent timesheets. It 
includes information on the timesheet period end date and description, as well as the total hours 
for each timesheet period. When you click a link in the T/S Period End Date column, Costpoint 
opens the Manage Timesheets screen that you can use to view additional details about the 
timesheet.  

 My Leave Balances — This is a numerical table that lists your leave accruals and leave 
balances per leave type. Lines are sorted by leave type. The hyperlinks in the Leave Type 
column bring you to the Manage Timesheets screen. On this screen, you have to open the Leave 
subtask so you can view additional leave information.  

 My Expense Reports — This is a numerical table listing your 10 most recent expense reports 
with their current status. The dashpart provides details on the expense report date, expense 
report description, and the total expense amount. To know more information about an expense 
report, you can click a link in the Description column to open the Manage Expense Report screen.  

 My Expense Authorizations — This is a numerical table that includes your 10 most recent 
expenses that have been authorized. You can view the date on which the expense authorization 
was created, the expense authorization description, and the total expense amount that has been 
authorized per expense authorization line. Clicking a link in the Description column launches the 
Manage Expense Authorization screen, where you can access more details about the expense 
authorization.  

 My Outstanding Expenses — This is a numerical table that lists your outstanding expenses. It 
gives you information on the batch type of the expense, the expense date, and the expense 
amount that you need to claim. The currency of the expense is also indicated. Lines on the 
dashpart are sorted based on the expense date, with the latest displaying on top. Note that this 
dashpart does not have hyperlinks to a drill-through application.  

Aside from drilling down from the dashpart to a screen in Time & Expense, you can perform the following 
actions on the dashboard:  

 Set up which dashparts to display and in what order.  

 Sort columns in a table.  

Note: If you are not licensed for Time & Expense and you do not have the appropriate 
module/application rights, Costpoint displays an error message when you try to access Home 
Dashboard and its drill-through applications.  

Contact your system administrators for access concerns. System administrators can assign users 
and user groups Read-Only, Full, or Deny rights to the Dashboards module, the Home Dashboard 
application, and any other applications using the Manage Users and Manage User Groups screens. 
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System Requirements  

This enhancement requires Costpoint 7.1.1 System JAR 046 (cp711_sys_046.zip).  

Application JAR Requirements  

The following table lists the Costpoint 7.1.1 screens affected by this update. It includes the required JAR 
version for each application, if applicable. 

Domain Module Application ID Application Name Application File 

Reports & 
Analytics  

Dashboards DBDHM Home Dashboard cp711_dbdhm_001.zip  

Known Issues  

Mobile: No Toggle Buttons for the Parameters and Reports Tabs  

In smartphone view, when you go to the Parameters tab, the toggle buttons for the Parameters and 
Reports tabs do not display, making you unable to go back to the Reports tab. You will need to close the 
dashboard and reopen it to view the Reports tab.  

In web view, when the navigation path area gets too long for the screen, the toggle buttons for the 
Parameters and Reports tabs are cut short, also making it difficult for users to access the Reports tab.  

Mobile: Header Issues on Tables  

In iOS, users can keep scrolling down even without the actual scroll bar. When users scroll up, issues 
occur on the header of dashparts presented as tables.  

Viewing the Online Help  

If you use Internet Explorer and the online help does not display correctly, you need to turn off 
Compatibility View for the browser. Click Tools » Compatibility View settings, and clear the Display 
intranet sites in Compatibility View check box. Then refresh the browser. Make sure you remove 
deltek.com (if listed) from the Websites you have added to Compatibility View list. 

 

Role-Based Dashboards: Limitation on the Number of Dashparts 
Displayed 
The number of dashparts that display on the Dashboard Reports tab depends on the number of 
dashparts you have open on the Parameters tab and your screen resolution. For example, if your screen 
resolution is lower than 1680 pixels, not all eight dashparts opened on the Parameters tab will be 
displayed on the Reports tab. 

Attention: Refer to the online help for more information on the Home Dashboard and the basic 
procedures that you can perform on this dashboard.  

You can also refer to Costpoint 7.1.1 Home Dashboard Overview video for an overview 
demonstration of the Home Dashboard, which is available in the following link: 
https://help.deltek.com/Product/Costpoint/USS/HomeDashboard. 

https://help.deltek.com/Product/Costpoint/USS/HomeDashboard
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As a workaround, you can do any of the following: 

 Toggle between the Parameters and Reports tabs to add (open) and remove (close) dashparts 
that you want to view.  

 Drag the dashpart table windows up or down on the Parameters tab to rearrange the dashparts. 
Costpoint displays the dashparts on the Reports tab in the order that they appear on the 
Parameters tab, first to last. 

 Set your screen resolution to 1920 pixels, which is the recommended resolution to view all 
dashparts. Note, however, that if your screen does not support 1920 pixels, you will not be able to 
set that resolution. 

Costpoint Integration 
There are no changes to Costpoint Integration in this release. 
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Budgeting and Planning 

Organization Budgeting 
There are no changes to Budgeting Administration for this release. 

Proposal Budgeting 
There are no changes to Budgeting Administration for this release. 

Project Budgeting 

Labor Report Updates 
Labor reporting within Budgeting & Planning is being updated to include hours that were budgeted by 
labor category (GLC or PLC) only, that is, without an identified resource,  within any of the following 
applications. 

 Project Budgeting » Budget/EAC Processing » Project Budget/EACs  

 Proposal Budgeting » Actions/Processing » Project Proposals (NPI4)  

 Proposal Budgeting » Actions/Processing » Project Non-Backlog Budgets (NPI7)  

When budgeting labor in the Staff Hours, Subcontractor Hours, or Consultant Hours subtasks in any of 
the above applications, hours assigned according to GLC or PLC will be reflected in certain associated 
reports. 

For this release, the following reports were updated to include labor hours budgeted by GLC or PLC.   

 Multi-Proposal Consolidation (Rev/Cost) (NPT3) 

 Non-Backlog Budget Revenue Summary (Rev/Cost) (NPT2) 

 Proposal Summary (Rev/Cost) (NPT1) 

 Project Labor Analysis (SPA6) 

 Project Status (SPA5) 

 Project Budgets/EACs Status (APS1,APS3) 

 Level Down Projects Future Revenue (BPL3) 

 Revenue Breakdown (BPA15) 

 T&M Budget Review (BPA13) 

For more information on how to budget labor by GLC or PLC, see 
“DeltekBudgetingandPlanning700ReleaseNotesBudgetLaborByGLC-PLC.pdf.” 

Project Budget Security Applied to Import of Budgets/EACs 
Back-end changes related to Project Budget Security have been applied to the following applications:  

 Import Budget/EAC from Scheduling App (BPU1, BPU3, BPU5, NPU1)  

 Import Budget/EACs from Excel 

https://dsm.deltek.com/DeltekSoftwareManagerAdministrator/
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These changes are automatically applied to these applications if Project Security to be based on is 
selected as Project Budget Security on the Project tab of Planning » Administration » Administration 
Controls » Configuration Settings (MAM10). 

When Project Budget Security is applied in these applications, uploaded projects are validated based on 
user rights. If the user does not have rights to a project, the project is not uploaded and the error is 
flagged. 

To learn more about Project Budget Security, see 
"DeltekBudgetingandPlanning700ReleaseNotesMaintainProjectBudgetSecurityApplication.pdf" 

Requirements 

The following table shows the required file for the screen affected by this update: 

Domain » Module » 
Application Group 

Application 
ID 

Application Name Required File 

Planning » Project 
Budgeting » Control and 
Utilities 

BNP_BGMB
PUX 

Import Budget/EAC 
From Scheduling 
App 
(BPU1,BPU3,BPU5,
NPU1) 

cp711_bnp_common_013.zi
p 

Planning » Project 
Budgeting » Control and 
Utilities 

BNP_BGPBP
UE 

Import Budget/EACs 
from Excel 

cp711_bnp_common_013.zi
p 
cp711_bp_bnp_bgpbpue_0
05.zip 

 

There are no changes to Budgeting Administration for this release. 

Resource Planning 
There are no changes to Budgeting Administration for this release. 

Administration 

New Period Rate Option for Calculation of Effective Rates 
The calculation of effective rates for salaried employees in Project budgeting was enhanced to derive a 
rate based on work hours per period versus work hours per annum, which was previously the default 
calculation.  

The addition of a period rate calculation allows for a more precise calculation of labor costs and revenue. 

How Effective Rates Are Calculated 

Prior to this enhancement, when effective rates were in use, the rate was based only on annual work 
hours, not hours per period. The annual rate was calculated by dividing the annual salary by annual work 
hours. For example,  

104,000 (annual salary) / 2080 (annual work hours) = 50.00 (effective rate)  

https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=8FE6BE1C-525D-47F4-B8F9-6AF12255A8C6
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Annual work hours are derived from Work Hours in a Year on the Salary Info subtask in People » Labor 
» Employee Basic Information Salary Info Subtask. If that field is empty, it defaults to hours set up in 
Fiscal Year Setup (MAM16), and if that is empty, it defaults to 2,080 hours. 

By contrast, the period rate calculation is not based on annual work hours, but is instead based on the 
available hours per period.   

The period for Project budgets (Project Budget Period field in Configuration Settings (MAM10)) can be 
based on either Costpoint accounting periods (and subperiods if used) or time collection periods, whereas 
Org budget periods are always based on Costpoint accounting periods, either accounting periods and 
subperiods or the accounting period only.  

For example, if the period includes 21 work days and the hours per day are 8, the hours available per 
period would be 168 (21 × 8). Extending this example to an employee who has an annual salary of 
104,000, the period effective rate would be calculated as follows:   

104,000 / 12 (fiscal periods) = 8,666.66 / 168 (hours available per period) = 51.59 (period effective 
rate) 

The annual rate example above yielded an hourly rate of 50.00, so the variance between the two rates is 
1.59. Therefore, especially when the budget runs less than a full year, the period effective rate produces 
a more accurate total for labor costs.   

Furthermore, if revenue is calculated using the hours worked multiplied by Project Labor Category rate, 
the variance will exist there as well. 

Configuring Rate Calculations 

Prior to this update, effective rates were enabled by selecting Use Effective Rates on the Org tab in 
Configuration Settings (MAM10). Because the effective rate was calculated only one way, the option was 
controlled by a check box, which was either checked or unchecked, indicating whether effective rates 
were in use or not in use.  

After the update is installed, your current status is maintained. If effective rates were in use prior to the 
update, it will default to the annual rate calculation. If effective rates were not in use, the feature is not 
enabled. 

To account for the new calculation option and its effect on Project Budgeting, the following changes were 
made: 

 The field label for the option was changed to Effective Rates to Use. The control was changed 
from a check box to a drop-down list with the following options: 

 None – Select this option if you do not want to use effective rates. This will be the default if 
effective rates are not already in use at the time of installation. 

 Annual Rates – Select this option to calculate the effective rate based on annual hours. This 
will be the default if effective rates are already in use at the time of installation. 

 Period Rates – Select this new option to calculate effective rates based on hours per period. 

 The option was moved from the Org tab to the General tab, because it will affect both Org 
Budgeting and Project Budgeting, including all of the following Project Budgeting applications: 
Project Budgeting » Budget/EAC Processing » Project Budget/EACs  

 Proposal Budgeting » Actions/Processing » Project Proposals (NPI4)  

 Proposal Budgeting » Actions/Processing » Project Non-Backlog Budgets (NPI7) 

 Additionally, the Refresh Process was also updated to capture changes related to this 
enhancement.  



Budgeting and Planning 

Cumulative Release Notes for October 2018 31 

 

Coming Soon… 

The period rate calculation will be applied to Organization Budgets – Outlooks in November 2018, and as 
part of that same update, Organization Budget Cycle Initialization (AOM3) will be updated to include a 
new Standard Annual Hours column in the Employee Rates subtask. This will be used in conjunction with 
the Period Rate setting to calculate effective rates.  

Requirements 

The following table shows the required file for the screen affected by this update: 

Domain » Module » 
Application Group 

Application ID Application Name Required File 

Planning » 
Administration » 
Administration 
Utilities 

BNP_BAPREF
RESH 

Refresh Process cp711_bp_bnp_baprefresh_0
11.zip 

Planning » 
Budget/EAC 
Processing » Project 
Budgeting 

BNP_BGMBPI
X 

Projects Budgets/EACs cp711_bnp_common_013.zip 

Planning » 
Administration » 
Administration 
Controls 

BNP_BAMMA
M10 

Configuration Settings 
(MAM10) 

cp711_bnp_common_013.zip 
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Time and Expense 

Usability Enhancement 

Pop-up Dialog Boxes  
As part of the ongoing effort to improve usability, several interface elements related to time and expense 
entry have been converted to pop-up dialog boxes.  

The pop-up dialog boxes either display automatically due to a workflow trigger, such as when a rejected 
or revised form requires an explanation, or display when the user clicks a hyperlinked field value (for 
example, an ID or revision number). 

Where added, the pop-ups eliminate other interface elements, such as tabs or subtasks, which previously 
required the user to navigate to a different location on the form to complete an action or view data, and 
when the dialog box is closed, the user now remains in the same location on the form.  

The specific areas that have been converted as part of this enhancement are described below.  

Line Level Approval – Approved Lines 

Information about a timesheet line that has been approved now displays in pop-up dialog box. 

This change was applied to the following applications: 

 Timesheets » Manage Timesheet 

 Timesheets » Manage/Approve Timesheets 

Line Level Approval – Rejected Lines  

Information about a timesheet line that has been rejected now displays in pop-up dialog box. 

This change was applied to the following applications: 

 Timesheets » Manage Timesheet 

 Timesheets » Manage/Approve Timesheets 

Line Level Approval – Pending Lines 

Information about a timesheet line that is pending approval now displays in pop-up dialog box. 

This change was made in the following applications: 

 Timesheets » Manage Timesheet 

 Timesheets » Manage/Approve Timesheets 

Time 

Creation of Timesheets Not Listed As Missing  
The Timesheets » Manage/Approve Timesheets screen was updated to allow the creation of 
timesheets that are not already listed as Missing. 
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Expense 

Database Attachments Conversion Utility 
An Expense Report Convert Attachment application was added to Expense » Expense Utilities.  

 
This new utility converts attachments stored in the 9.0.1 database to PDFs so that the files are available 
to users after the upgrade to version 10.0 is complete. The utility should be used during the post-
installation process, following the initial upgrade. 

This application should be run only after the Alternate File Location has been set up and configured. 
Instructions for configuring the Alternate File Location are included in the following guide 
DeltekTimeandExpense1000PostInstallationConfigurationGuide.pdf. 

When an upgrading customer clicks Expense » Expense Utilities » Expense Report Convert 
Attachments, existing attachments are automatically converted.  

The converted files are then automatically stored in the Alternate File Location ( Administration » 
System Administration » File Management » Manage Alternate File Locations ) for attachments.  

The utility includes the following fields: 

 Attachments found in Database  ̶  This is the number of attachments found in the 9.0.1 
database. 

 Previously Converted  ̶  This is the number of attachments that were converted in previous runs. 

 Number of Attachments Converted  ̶  This is the number of attachments converted in the 
current run. For example, if all the attachments found have previously been converted, this field 
will display “0” because no attachments were found to convert in the current run. Note that the 
utility run automatically after the screen is opened.  

All Days Selected by Default for Meal Allowances 
In the Manage Expense Report » Claimed Expenses » Meal Totals Details table, all days for meals allowances are 
selected by default so that users do not have to individually select each line item. 
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. 

Configuration 
There are no updates in this area. 

 



 

 

About Deltek 
Better software means better projects. Deltek is the leading global provider of enterprise software and 
information solutions for project-based businesses. More than 23,000 organizations and millions of users 
in over 80 countries around the world rely on Deltek for superior levels of project intelligence, 
management and collaboration. Our industry-focused expertise powers project success by helping firms 
achieve performance that maximizes productivity and revenue. www.deltek.com 

http://www.deltek.com/
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